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NONFICTION EDITING 101 
 

Instructor: Erin K. Brown 
 

LESSON #4 
 

Documentation 
 
Introduction 
Documenting sources used in a book can seem to be an overwhelming task. Some people are 
either confused by this aspect of writing/editing or are unaware of the necessity of giving credit 
to those whose works are referenced. Then there’s the question of how to format citations. 

 
If writers use quotes or ideas from books, magazine articles, speeches, recordings, emails, etc., 
they must list these sources in either the notes or bibliography. 

 
Let me give you a few reasons a manuscript requires proper documentation: First, copyright 
laws. If authors use another’s intellectual property, they would violate copyright laws by 
claiming (or even alluding) that the material belongs to them. You probably recall at least one 
lawsuit of many brought against J. K. Rowling concerning some of the Harry Potter books. No 
matter who won the suits, they were costly in time, money, and emotions. If your clients use 
ideas, names, etc., they must document the source and, in some cases, may need to get written 
permission from the copyright holder (more on this later). 

 
A second reason to document intellectual property is that it is the ethical thing to do. The first 
example that pops into mind is Al Gore saying in an interview, “I took the initiative in creating 
the internet.” Was he clumsy in speech, or did he take credit for “inventing” the internet? The 
debate rages. (The internet was developed by many people—Vint Cerf is called the “father of the 
internet”—in many places and over a span of time.) Even if Gore meant that he perceived the 
future of the internet and, therefore, pushed for funding its development, his words seem to give 
himself credit where none is due. Equally troublesome is the ridicule he received because of his 
careless/erroneous statement. 

 
The third reason is simply the consideration of the readers. When the author mentions an 
idea or concept, or quotes from other works, the reader may want to know more about it. 
Providing documentation allows the reader to pursue further knowledge of this topic. 
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Quotations 
It is the author’s responsibility to accurately quote another’s words. The author has access to the 
original material, not the copyeditor, so the copyeditor’s job is to 

 
• bring to the author’s attention any spelling, punctuation, or wording questions about the 

quoted material (Sometimes it’s faster for me to try to locate the quotation than it is to 
contact the author to confirm the quote. I choose a significant phrase from the quote 
and insert it, within quotation marks, in the search engine. If it pops up, I compare it 
with what the author has. If I spot any differences, or I can’t find the quotation, I’ll 
query the author with my findings.); 

• make sure the quotation in running text is enclosed within quotation marks (If the 
quoted material uses quotation marks within it, change those to single quotation 
marks—unless it is a block quotation [more on that later].); 

• properly apply ellipses if needed; and 
• ensure the quotation is referenced and documented. 

 
Reference Marks 
Merriam-Webster says this about reference marks: “a conventional mark (as *, †, or ‡) placed in 
written or printed text to direct the reader’s attention especially to a footnote.” Unless the work is 
an academic piece, you will want to discourage the use of footnotes. If you’re editing for a 
publisher, the PM will make that decision. Endnotes are preferred over footnotes. They are 
located at either the end of each chapter or the end of the book and listed according to chapters. 
Instead of the above marks, MW recommends quoted material should receive a superscript 
number immediately following the word or closing punctuation of the quoted material. For 
example, “The number of cows in Montana is greater than the human population.”1 The next 
running text quotation will receive a superscript 2, and so on. (Superscript is found on the Home 
tab on Font under Effects. Check the Superscript box, then type the number. Don’t forget to 
uncheck the Superscript box to get out of it. Or you can use Ctrl+Shift+=.) 

 
If the manuscript has several numbered quotations, I suggest numbering them and documenting 
them by chapter. The first quotation of each chapter starts the numbering over with superscript 1. 
The documentation in the notes section is divided into the corresponding chapters that contain 
quoted material. 

 
Running (Run-In) Quotations 
A running, or run-in, quotation simply means that the quotation is included within the text. It 
receives opening and closing double quotation marks. If any quoted material is included within 
the quotation, it takes single quotation marks. 

 
For example, if you were to open the book Secrets of a Freelance Writer by Robert W. Bly to 
page 112, the fourth paragraph begins exactly like this: For example, if I write an article on 
“How to Sell Insurance Through Direct Mail,” I can look in my notebook and send a reprint of 
the article to advertising managers at insurance companies who previously requested information 
on my services. 

 
But note the double and single quotation marks when I properly quote this sentence: Robert W. 
Bly wrote, “If I write an article on ‘How to Sell Insurance Through Direct Mail,’ I can look in 
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my notebook and send a reprint of the article to advertising managers at insurance companies 
who previously requested information on my services.”1 

 
The quotation is set off with opening and closing quotation marks, and any other quoted material 
within the quotation is enclosed within single opening and closing quotation marks. 

 
Block Quotations 
Generally, if the quoted material is five or more lines (or more than one hundred words), format 
it into a block quotation. A block quotation starts on a new line, has wider margins, and does not 
take opening and closing quotation marks. Following is a quote from one of my manuscripts. I 
have it set as a block quotation. 

 
Modern-day home-school pioneers had no idea what homeschooling looked like. 
We had never seen it; we had never experienced it; we had never known any 
parents who homeschooled their children or had been homeschooled themselves. 
Oh, we were acquainted with the stories about colonial America, when reading 
and ciphering took place in the home. We were aware that Thomas Edison, 
Sandra Day O’Connor, and other well-known Americans had been homeschooled, 
but these stories were devoid of practical details for the modern home-school 
experience. Unfortunately, I could not call up Mrs. Edison and inquire about 
young Tom’s tutelage. Neither could I invite Sandra and her mother over for tea, 
eliciting wisdom from their day-to-day homeschooling. 

 
A block quotation is sometimes referred to as an extract. Occasionally, you might have to code 
the block quotations. If so, the publisher will supply you with codes and instructions. (More on 
type coding in Lesson 7.) 

 
Ellipses with Quotes 
Often a quote won’t include every word or sentence from the original selection, just that which is 
pertinent to the subject at hand. When words or sentences are omitted from the quote, ellipsis 
points are used to indicate missing material. Let’s use the block quotation from above, but I’ll 
leave out part of it so I can demonstrate two uses of ellipses in quotes. 

 
Modern-day home-school pioneers had no idea what homeschooling looked 
like ........ Oh, we were acquainted with the stories about colonial America when 
reading and ciphering took place in the home. We were aware that Thomas 
Edison, Sandra Day O’Connor, and other well-known Americans had been 
homeschooled, but these stories were devoid of practical details for the modern 
home-school experience. Unfortunately, I could not call up Mrs. Edison and 
inquire about young Tom’s tutelage. Neither could I invite Sandra and her mother 
over for tea, eliciting wisdom from their day-to-day homeschooling. 

 
Here you see that I omitted the second sentence of the paragraph. The previous sentence ends 
with a period followed by a space then the ellipsis points, which also use spaces. 
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In this next example, I cut off the first sentence and joined it to the middle of another sentence. 
Because the first sentence was not complete, no sentence-ending period is included—just the 
three ellipsis points with spaces before and after each point. 

 
Modern-day home-school pioneers . . . were acquainted with the stories about 
colonial America, when reading and ciphering took place in the home. We were 
aware that Thomas Edison, Sandra Day O’Connor, and other well-known 
Americans had been homeschooled, but these stories were devoid of practical 
details for the modern home-school experience. Unfortunately, I could not call up 
Mrs. Edison and inquire about young Tom’s tutelage. Neither could I invite 
Sandra and her mother over for tea, eliciting wisdom from their day-to-day 
homeschooling. 

 
 
Permissible Changes to Quotations 
CMOS gives a list of permissible changes to quotations (13.7–8), but I’d like to quickly call your 
attention to sic, which means “thus” or “so” and is put in italics within brackets, [sic], to indicate 
a word or spelling is intentionally written that way. It is not used simply to point out variant 
spelling. (Please see CMOS 13.61.) 

 
If authors insert an explanatory comment or clarifying word within a quotation, they must put it 
within brackets so that the reader knows it is the author’s comment and not part of the original 
quote. 

 
To emphasize a word, phrase, or sentence within the quotation, the author can put that portion in 
italics and at the end of the quote add one of the following phrases within parentheses: “italics 
mine,” “italics added,” “emphasis mine,” or “emphasis added” (CMOS 13.62). Use the same 
phrase throughout the manuscript. Instead of this method, you can add a statement to your 
copyright page: “Italics in quoted material is the author’s emphasis.” 

 
Quoting Scripture Verses 
I edit and proofread numerous manuscripts by Christian authors who typically quote several 
Scripture verses in their manuscripts. Though you may not work in this field, I want to include a 
small section because these quotations have some peculiarities worth knowing. 

 
Let’s say your client quotes the following verse. Please note how it is referenced. “For God so 
loved the world that he gave his one and only Son, that whoever believes in him shall not perish 
but have eternal life” (John 3:16 NIV). 

 
First, I suggest verifying that this verse is correctly copied. You’ll have to consult the New 
International Version (NIV). (Biblegateway.com is a good go-to source.) Second, though the 
verse in the Bible ends with a period or a comma, one is not put at the end of the quotation. 
Instead, place a period after the closing parenthesis. Within the parentheses is the Scripture 
reference, followed by the abbreviation of the version of the Bible in either all caps or small caps 
(The Christian Writer’s Manual of Style, 4th edition, uses all caps [see page 330], but some of 
my publishers prefer small caps). However, if you know the manuscript will be in e-book version 
only, use full caps because small caps won’t convert. If the quoted verse ends in an exclamation 

https://www.biblegateway.com/
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point or question mark, include that before the closing quotation mark, but also place a period 
after the closing parenthesis. “And the Lord said unto Cain, Why art thou wroth? and why is thy 
countenance fallen?” (Gen. 4:6 KJV). 

 
Let’s talk about the statement “the version of the Bible used.” If the author uses one version 
throughout the entire manuscript, you do not include the version abbreviations as part of the 
reference. You will, however, include the permission statement from the publisher of the version 
used on the copyright page. In the case of the example of the New International Version, insert 
on the copyright page the following: 

 
All Scripture quotations are taken from the Holy Bible, New International 
Version®, NIV®. Copyright © 1973, 2011 by Biblica, Inc™. Used by permission 
of Zondervan. All rights reserved worldwide. www.zondervan.com. 

 
If authors use more than one version, they will have one primary version and one or more 
secondary versions. The primary version does not need to be noted with the reference, but the 
abbreviation of the secondary version(s) is included in small/all caps, as I’ve done in the above 
examples. The permission statements on the copyright page must include all versions used and 
be worded like this: 

 
[This opening phrase designates this as the primary version.] Unless otherwise 
noted, all Scripture quotations are taken from the Holy Bible, New International 
Version®, NIV®. Copyright © 1973, 2011 by Biblica, Inc™. Used by permission 
of Zondervan. All rights reserved worldwide. www.zondervan.com. [Secondary 
versions use the following opening phrase.] Scripture quotations marked NASB are 
taken from the New American Standard Bible, © Copyright 1960, 1995 by The 
Lockman Foundation. Used by permission. 

 
Each Bible publisher has its specific permission wording that is to be included on the copyright 
page, as well as an allowable number of verses that can be quoted within a single work. Consult 
the appropriate websites for the permission statements. 

 
 
Anonymous and Unknown Authors 
I did a quick search on Amazon.com for “anonymous author” in Books. Care to guess how many 
results I got? 12,171. That’s a lot of titles by Anonymous! 

 
If a citation includes a book written by Anonymous, treat it as you would the author’s name 
while documenting it—Anonymous in the place of the author’s name. If, however, the book’s 
author is unknown, simply begin the citation with the book title—ignore the author’s name. If 
the text contains quoted material from an unknown author (the author should have diligently 
searched for the source), the wording can be something like this: Someone once wrote, “Montana 
has more cattle than people.” 

 
But some situations call for attribution. I’ve edited several Chicken Soup for the Soul titles. The 
stories begin with a chapter-opening quote placed under the story title. The quotation is centered 

http://www.zondervan.com/
http://www.zondervan.com/
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and in italics. On the next line in Roman and right justified is the attribution. If the author is 
unknown, they use the words Source Unknown or just Unknown: 

 
 

Story Title 
 

Lorem ipsum dolor sit amet, ad corrumpit adversarium his, eu pro aliquip salutatus consequun. 
Unknown 

 
 
Formatting Documentation 
Some authors avoid using quotations and referring to other sources simply because they don’t 
know what is included in the documentation and how to format it. I remember the first 
manuscript I received that included several pages (about thirty!) of bibliographic entries. Though 
I didn’t exactly panic, my heart rate increased, and I’m sure my labored breathing could be heard 
by those in the next room. But now that I’m familiar with them, I rather enjoy editing the notes 
and bibliography sections of manuscripts. A PM from a publisher I freelance for had two galleys 
that needed proofreading. One was fiction, the other nonfiction with lots of notes. She asked if I 
knew how to proofread/edit notes. I did, of course, but I had to chuckle because she didn’t and 
needed someone to rescue her! 

 
As I mentioned earlier in this lesson, any source the author quotes from must be noted and 
documented. And quotes can come from not only books and magazines but also websites, blogs, 
emails, and many more sources. CMOS chapters fourteen and fifteen (yes, two long chapters) 
cover everything you need to know about documentation. If you want to break into editing 
nonfiction books, you must study these chapters. 

 
Before I show you examples of documentation, let’s review the purpose of notes and a 
bibliography. Notes give credit to the material being quoted within the manuscript, and notes 
give additional information about the content. A bibliography provides additional sources related 
to the content. Pay attention to the formatting differences between note and bibliographic entries. 

 
Notes 

• At the close of quoted material within the text, designate it with a superscript numeral 
and place the corresponding number before the note/documentation. 

• Put in order of appearance in the text. 
• Only the first line is indented. 
• List by author’s first name followed by the last name. 
• Separate note elements with commas. 
• Enclose facts of publication in parentheses. 

 
Bibliography 

• The first line is flush; subsequent lines are indented (flush-and-hang style). 
• Put in alphabetical order by author’s last name. 
• Author’s last name first, followed by first name (additional authors: first name followed 

by the last name). 



Nonfiction Editing 101, Lesson 4, Brown | 7 
© 2016, 2021 Erin K. Brown. All rights reserved. Reproduction or redistribution, all or part, is prohibited. 

 

• Separate elements with periods. 
• Facts of publication are not enclosed in parentheses. 

 
Each example below is given first as a note and followed by a bibliographic entry. For numerous 
specific examples, see chapters fourteen and fifteen of The Chicago Manual of Style, 17th 
edition. Use this handy reference of the most commonly used sources. This was compiled from 
chapters sixteen and seventeen of CMOS, fifteenth edition, but the format is current. My 
comments are highlighted. 

 

Book with one author (If a state is required after the city of publication, use the postal 
abbreviation. For example, Grand Rapids, MI) 

1. Wendy Doniger, Splitting the Difference (Chicago: University of Chicago Press, 
1999), 10–33. 

 
Doniger, Wendy. Splitting the Difference. Chicago: University of Chicago Press, 1999. 

 
Book with two authors 

2. Guy Cowlishaw and Robin Dunbar, Primate Conservation Biology (Chicago: 
University of Chicago Press, 2000). 

 
Cowlishaw, Guy, and Robin Dunbar. Primate Conservation Biology. Chicago: University 

of Chicago Press, 2000. 
 
Book with more than three authors 

3. Edward O. Laumann et al., The Social Organization of Sexuality: Sexual 
Practices in the United States (Chicago: University of Chicago Press, 1994). 

 
Laumann, Edward O., John H. Gagnon, Robert T. Michael, and Stuart Michaels. The 

Social Organization of Sexuality: Sexual Practices in the United States. Chicago: 
University of Chicago Press, 1994. 

 
Editor, translator, or compiler 

4. Richmond Lattimore, trans., The Iliad of Homer (Chicago: University of Chicago 
Press, 1951). 

 
Lattimore, Richmond, trans. The Iliad of Homer. Chicago: University of Chicago Press, 

1951. 
 
Augustine. Confessions. Translated by R. S. Pine-Coffin. Harmondsworth, UK: Penguin 

Books, 1971. 
 
Chapter or other part of a book 

5. W. Freeman Twaddell, “A Note on Old High German Umlaut,” in Readings in 
Linguistics I: The Development of Descriptive Linguistics in America, 1925–1956, 4th 
ed., ed. Martin Joos (Chicago: University of Chicago Press, 1957). 
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Twaddell, W. Freeman. “A Note on Old High German Umlaut.” In Readings in 
Linguistics I: The Development of Descriptive Linguistics in America, 1925–1956. 
4th ed. Edited by Martin Joos. Chicago: University of Chicago Press, 1957. 

 
Preface, foreword, introduction, and similar parts of a book 

7. James Rieger, introduction to Frankenstein or, The Modern Prometheus, by 
Mary Wollstonecraft Shelley (Chicago: University of Chicago Press, 1974). 

 
Rieger, James. Introduction to Frankenstein or, The Modern Prometheus, by Mary 

Wollstonecraft Shelley. Chicago: University of Chicago Press, 1974. 
 
Journal article 

8. John Maynard Smith, “The Origin of Altruism,” Nature 393 (1998): 639–40. 
 
Smith, John Maynard. “The Origin of Altruism.” Nature 393 (1998): 639–40. 

 
Article in an electronic journal 

33. Mark A. Hlatky et al., “Quality-of-Life and Depressive Symptoms in 
Postmenopausal Women after Receiving Hormone Therapy: Results from the Heart and 
Estrogen/Progestin Replacement Study (HERS) Trial,” Journal of the American Medical 
Association 287, no. 5 (2002), 
http://jama.amaassn.org/issues/v287n5/rfull/joc10108.html#aainfo. 

 
Hlatky, Mark A., Derek Boothroyd, Eric Vittinghoff, Penny Sharp, and Mary A. 

Whooley. “Quality-of-Life and Depressive Symptoms in Postmenopausal Women 
after Receiving Hormone Therapy: Results from the Heart and Estrogen/Progestin 
Replacement Study (HERS) Trial.” Journal of the American Medical Association 
287, no. 5 (February 6, 2002), 
http://jama.amaassn.org/issues/v287n5/rfull/joc10108.html#aainfo. 

 
Popular magazine article 

9. Steve Martin, “Sports-Interview Shocker,” New Yorker, May 6, 2002, 84. 
 
Martin, Steve. “Sports-Interview Shocker.” New Yorker, May 6, 2002, 84. 

 
Newspaper article 

10. William S. Niederkorn, “A Scholar Recants on His ‘Shakespeare’ Discovery,” 
New York Times, June 20, 2002, Arts section, Midwest edition. 

 
New York Times, June 20, 2002, Arts section. 

 

Chicago style puts newspaper citations in running text, not in parenthetical notes: 
As William Niederkorn noted in a New York Times article on June 20, 2002, . . . 

http://jama.amaassn.org/issues/v287n5/rfull/joc10108.html#aainfo
http://jama.amaassn.org/issues/v287n5/rfull/joc10108.html#aainfo
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Paper presented at a meeting or conference 
13. Brian Doyle, “Howling Like Dogs: Metaphorical Language in Psalm 59” (paper 

presented at the annual international meeting for the Society of Biblical Literature, 
Berlin, Germany, June 19–22, 2002), 15–16. 

 
Doyle, Brian. “Howling Like Dogs: Metaphorical Language in Psalm 59.” Paper 

presented at the annual international meeting for the Society of Biblical Literature, 
Berlin, Germany, June 19–22, 2002. 

 
Personal communications 
In an email message to the author on October 31, 2002, John Doe revealed that . . . 

 

Or the reference may be given in a note: 
2. John Doe, email message to author, October 31, 2002. 

 

Email messages, letters, and the like are rarely listed in a bibliography or reference list. 
Note that individuals’ email addresses should be omitted. 

 
Movie 

1. Movie Title, Directed by Mary Smith, Hollywood, CA: Bigshot Productions, 
2004. 
Movie Title. Directed by Mary Smith. Hollywood, CA: Bigshot Productions, 2004. 

 
 
Dictionary/Encyclopedia 
“Well-known reference books, such as major dictionaries and encyclopedias, are normally 
cited in notes rather than in bibliographies. The facts of publication are often omitted, but 
the edition (if not the first) must be specified.” See CMOS 14.232 for more details. 

1. Encyclopedia Britannica, 15th ed., s.v. “Salvation.” 
2. Dictionary of American Biography, s.v. “Wadsworth, Jeremiah.” 

 

Certain reference works, however, may be listed with their publication details. 
3. MLA Style Manual and Guide to Scholarly Publishing, 2nd ed., ed. Joseph 

Gibaldi (New York: Modern Language Association of America, 1998), 6.9.4. 
 
MLA Style Manual and Guide to Scholarly Publishing. 2nd ed. Edited by Joseph Gibaldi. 

New York: Modern Language Association of America, 1998. 
 
Newsletter 
See CMOS 14.236 for details on how to cite pamphlets, reports, newsletters, and the like. 

 
Subsequent references to already cited works 
State the author’s last name, a shortened title of the work, and the page number, if applicable. 

10. Niederkorn, “A Scholar Recants.” 
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Consecutive references 
When you have two or more consecutive references to the same note, simply use Ibid., which 
means “in the same place.” If the page number is the same, it can be omitted; if it is different, 
include it. 

1. Wendy Doniger, Splitting the Difference (Chicago: University of Chicago Press, 
1999), 10–33. 

2. Ibid., 50. 
 

With increasing numbers of books published daily on Kindle, chances are good that you will run 
into citations from a Kindle book. Here’s how to do that with the location number: 

1. The Works of Jonathan Edwards, vols. 1–2 (Edinburgh: Banner of the Truth, 
2011), Kindle location 28482–84. 

 

You will likely encounter many sources from the internet (do not use hyphens to show a break in 
the URL): 

1. “Forgiven Knightley,” Sun, accessed March 24, 2016, www.thesun.co.uk/sol/ 
homepage/showbiz/bizarre/4285973/Atheist-actress-Keira-Knightley-wishes- 
she-believed-in-God.html. 

 

This website is a great source when you have to document electronic sources: 
https://owl.purdue.edu/owl/research_and_citation/chicago_manual_17th_edition/cmos_formatting
_and_style_guide/web_sources.html. 
 

Tips When Editing and Proofreading Notes 
Before I begin editing or proofreading a manuscript that includes notes/bibliographies 
(remember, it’s the author’s responsibility to provide documentation; you make sure it’s 
formatted correctly), I print the section and keep it handy as I move through the manuscript. 
When I come to, say, chapter three and find a superscript 1, I grab the printed notes, locate 
number 1 under the chapter three heading, jot the page number next to it, and verify that the 
documentation matches the text content. Many times, I’ve encountered a situation where I had 
either too few or too many notes. I have to query the author or PM if I can’t figure out the 
problem. 

 
Once I’ve completed the edit/proofread of the text, I go through my printed copy of the 
notes/bibliography and do a hard-copy edit, making sure all the information is included and 
formatted correctly (for whatever reason, I catch more errors on a hard copy than I do on the 
electronic copy). I transfer the corrections from the hard copy to the electronic document. You 
may want to skip the hard-copy edit and just do it on the electronic copy, but I do suggest 
printing out a copy of the notes so you can easily reference them while editing the text. 

 
 
Another Important Note about Notes 
I can just about guarantee that at some point in your nonfiction editing career, you will have to 
convert footnotes to endnotes, combine into one file several files that contain endnotes, and 
delete notes (which affects their sequential numbering in the text and in the notes section). 
Unless you know how to do this, frustration will become your nightmare—trust me, I know. I 

http://www.thesun.co.uk/sol/
https://owl.purdue.edu/owl/research_and_citation/chicago_manual_17th_edition/cmos_formatting_and_style_guide/web_sources.html
https://owl.purdue.edu/owl/research_and_citation/chicago_manual_17th_edition/cmos_formatting_and_style_guide/web_sources.html
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didn’t know how to do any of these things, so I had to learn on my own. But once I did, I was 
one happy editor. Let me share my findings. 

 
Converting Footnotes to Endnotes 
This is a very easy operation Word does for you. Go to the References tab, and at the bottom 
next to Footnotes, click the launcher (the little arrow). Footnotes should be chosen, click 
Convert, then OK or Apply. Sometimes Word automatically changes the Arabic numerals to 
Roman, so under Format, choose Arabic numerals, then Apply. 

 
For Word for Mac OS X (2011), from the Insert menu, select Footnote. Click Convert and select 
from one of the following options: 

 
• Convert all footnotes to endnotes 
• Convert all endnotes to footnotes 
• Swap footnotes and endnotes 

Click OK in each of the dialog boxes. 

Next, go to View. On the Views menu, click on the Draft mode and then go back to the 
References tab and select Show Notes. A smaller screen will appear. In the dialogue box, choose 
Line Separator. The line that separates the text from the notes will appear. Highlight it and delete 
it. 

 
Create One File from Many Files That Include Notes 
Open the first document of the several you want to combine. Go to the Insert tab. In the Text 
box, click the Object launcher (down arrow). Click “Text from File”. A dialogue box (Insert 
File) will open, allowing you to pick all of the files you want to add. (See figure 1.) 
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Figure 1: Insert File dialogue box 
 
 
Choose the files you want to add and then click Insert. 

 
So far so good. But what if a couple, or all, of these files have notes and you need to get all of the 
notes at the end of the last chapter? To complicate things a bit, if the author used the Insert 
Footnote feature of Word, you need to keep the notes separated by their respective chapters and 
maintain their original numbering. In other words, let’s say chapter 1 has twelve notes, numbered 
one through twelve. Chapter two has five notes, numbered one through five. You want to keep 
this original numbering because your notes section will be divided into chapters. You don’t want 
the notes from one chapter running into the next chapter. 

 
Sound like a nightmare in the making? Here’s a really easy solution. Create Section Breaks at the 
end of each chapter by going to your Quick Access Toolbar and locating the Page Break icon 
(you should have added this in Lesson 1). Click Breaks launcher (down arrow to the right of the 
icon). Look under Section Breaks, and choose Next Page. 

 
While your file is open, use Ctrl+A to highlight it all. Then go to the References tab>Footnotes 
launcher, and make sure Endnotes is chosen. Under Format find Numbering, and choose from 
the dropdown menu Restart each section. Under “Apply changes”, choose “Apply changes to 
selected text”. Then choose Apply. (See figure 2.) 

 

Figure 2: Moving multiple-files’ notes to the back of the document 
 
 
Voila! All of your notes are now at the back of the file. They’ve retained their original 
numbering. All you need to do is create chapter divisions (type “Chapter #” and two line spaces). 
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That was easy, right? I wish someone had taught me this early on. But I’m thankful I know how 
to do this now and can share it with you. 

 
For additional information regarding quotations, study the following sections from CMOS: 13.9– 
29, 59–63. 

 

Summary 
I hope this lesson helps relieve some fear you may have about editing quotations, notes, and 
bibliographic entries. Remember that CMOS style is directed to general audience works. If you 
edit or write for a specific field (academic, medical, journals, etc.), you will likely face some 
minor differences, which you can find in the specific style guides a particular field uses. But 
what you’ve learned here gives you a solid foundation that will serve you well in any field. 

 
We learned about the importance of giving credit where credit is due, and we looked at some 
forms of quotations: running text, block, and Bible verses. And we learned about using ellipsis 
points within quotations, single and double quotation marks, and permissible changes within 
quotations. 

 
I gave you several examples from CMOS of formatting entries in both notes and bibliographies. 
And I gave you a tip on making sure authors have provided documentation on everything they 
have quoted or referred to within the text. 

 
I closed by showing you how to convert footnotes to endnotes. But best of all, you learned how 
to compile several files that contain notes into one file and move all the notes to the end of the 
last chapter/file. All this while keeping the notes numbered according to their original chapters 
and order. 

 
The more you work with notes and bibliographic entries, the less intimidating they will be. 

 
 

* * * 
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LESSON #4 ASSIGNMENTS 
 
Assignment #1 
 
Edit these notes. 

 
1. Sally Denton and Roger Morris, The Money and the Power (New York: Alfred A. 

Knoph, 2001), 6. 
2. Barbara Land and Myrick Land, A Short History of Las Vegas (Reno: University of 
Nevada Press, 1999), 100. 
3. Kenneth Keniston, The Uncommitted (New York: Dell Publishing, 1960), 25. 
4. Allen Ginsberg was a political activist who was widely considered to be the spokesman 

for the Beat Generation. In 1956 he published Howl, which was a denunciation of American 
culture and values. 

5. Matthew 14: 15–21; Mark 6:35–44; Luke 9:12–17; John 6:1–14. 
6. John A.T. Robinson, Honest To God (Philadelphia: The Westminster Press, 1963), 24. 
7. Ibid., 78. 
8. James A. Pike, The Other Side (Garden City, New York: Doubleday & Company, Inc., 

1968), 275. 
 
Assignment #2 

 

Edit this Bibliography. 
 
Roemer, William F. Jr. War of the Godfathers. New York: Donald I. Fine, Inc., 1990. 

 
Denton, Sally, and Roger Morris. The Money and the Power. New York: Alfred A. Knoph, 2001. 
Schulman, Bruce J. The Seventies. New York: the Free Press, 2001. 

 
Hal Rothman and Mike Davis. The Grit Beneath the Glitter. (California: University of California 
Press, 2002). 
Hal Rothman Neon Metropolis.New York: Routledge, 2002. 
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